
Film editing

Introduction

Once filming is finished, it’s time to edit your material.

Depending on the type of video you want to produce and the filming devices you used, you can edit your
material on a computer, tablet or even a smartphone.

You will usually need a video-editing program to help you review and cut your footage. Manufacturers
of cameras, smartphones and tablets often include the necessary editing software when they sell you the
device. There is a variety of different programs, but their basic functionality and interface are often similar.

In this chapter you’ll learn basic skills for editing video in Adobe Premiere Elements using a computer. A
computer with a good keyboard and mouse is the most comfortable way of editing a video. Premiere Elements
is a widely used and inexpensive (€90) editing program suitable for both simple and more complex projects.

We’ll show you how to create a film project, insert filmed material and edit it. This includes working
with transitions and adding titles, music and voice-overs.

 

Vision in action
 

• Find a space suitable for editing. Use headphones so that you’re not distracted by what’s
happening around you.
• Watch all the material before you start editing, so you know what you’re working with. You
can check your clips also using  any video player. Make notes.
• Before you create a new film project in the editing software, make sure the folders and files
you’ll use are well organised. Do this in Windows Explorer (or another file browser), then
import the files in Adobe Premiere Elements (or another video-editing program) and make
sure you’ve retained that folder structure there.
• Learn the shortcuts of your editing program and use them to speed up your work. The main
ones in Premiere Elements are:
    ⚬ Save the project: Ctrl + S
    ⚬ Undo one or several editing steps: Ctrl + Z:
    ⚬ Select all the items in one area (for example all the files in a folder in the ‘Project
elements’ window, or all the material in the timeline): Ctrl + A
    ⚬ Play/pause the video in the preview window: Spacebar
    ⚬ Zoom in and out in the timeline: + / –
    ⚬ Delete one or more selected clips in the timeline: Del
    ⚬ Finish editing text elements and switch to adjusting their position: Esc
• Regularly discuss your progress with people in your group, and agree what needs to
improve.
• Save regularly (Ctrl + S)!
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Equipment and tools

To edit your film you’ll need:

a video-editing program installed on your computer.
a sufficiently fast computer that meets the requirements of the editing software, in terms of operating
system, processor speed, RAM and HDD capacity.
a mouse. You won’t be able to edit your video using a laptop touchpad.
good speakers, or headphones (to avoid disturbing others that might be working in the same room).
Y-adapters for headphones. These are really helpful if you have a couple of people working together on the
same computer.
if possible, a second computer screen. You can use this to preview your work more easily.

Main section

The interface of most editing programs consists of two basic elements:

an editing window, where video and audio material is placed along a timeline and edited
a preview window, where you can watch the video.

It’s hard to find free editing software for Windows that is suitable for more complex projects. Programs
like Adobe Premiere Elements, Pro CC or Magix Video Deluxe 15 have free trial versions, but they expire after a
month and sometimes have limited functionality.

The program we’re using as an example in this chapter is Adobe Premiere Elements 13, available for Windows
and Mac iOS. It has all the functionality you need for both simple and complex projects, and it supports a variety
of file formats. The software costs about €90, and students and educational institutions may be able to get a
discount.

Less complex projects can also be edited in Movie Maker, a program that comes free of charge with
Microsoft Windows. To familiarise yourself with other editing programs, please refer to online manuals and
tutorials.

To help us explain the basic process of editing, imagine that you’ve just shot a video about a particular
profession. You shot the video with just one camera. The material consists of an interview (referred to
as ‘interview images’ below) with a craftsman and additional image material illustrating what he does and his
workplace (‘sectional images’). You’ve named the project ‘Portrait of a professional’.



Preparing to edit

Before you start editing, you’ll need to pre-sort your material, to get a good overview of everything you filmed.

You can start by browsing shots in Windows Explorer or another file browser, and deciding which ones you don’t
need. You can then sort shots in different folders by scene and date.

If you’re taking part in a film project at school or at a youth club but you don’t have editing software at
home, you can still view the material in Windows Media Player, VLC or any other program that plays
video. Note down any comments and time codes to help you with editing when you’re back at school or
at the youth club.

The file format your camera uses won’t necessarily be compatible with the editing software. If the program
can’t import files from your camera, find out what formats the software does support and convert your files
using a program like SUPER (free) or Adobe Media Encoder.

If your computer is slow, working with compressed file formats (for example .mts) can make the editing program
– and the whole editing process – very slow too. It’s a good idea to convert your files to a less compressed
format, for example .avi. You can do this in the conversion software we discussed above, but make sure you
have enough space on your hard drive first.

Something else that can significantly slow down your editing program is video material with very high
resolution. One solution is to convert the high-resolution files into files with lower resolution and use those while
you edit. Once you’re done editing, replace the low-resolution files with the high-resolution ones before
outputting the project. In Adobe Premiere Elements, right-click on the imported video file in the ‘project
elements’ panel, click on ‘replace video file’ and select the high-resolution version.

All other files you’d like to use, including sound recordings and image material, should be saved in subfolders in
the main project folder. In the case of the ‘Portrait of a professional’ project, for example, your main folder will
be given the project name (‘Portrait of a professional’) and there will be two subfolders: ‘interview images’ and
‘sectional images’ in which files will be sorted before editing.

Creating a new project in Adobe Premiere Elements 13

Open Adobe Premiere Elements.

Select Video Editor->New Project.

The workspace where you’ll be editing your video will appear. Click on ‘Save’ top right and give the project
a name: ‘portrait_of_a_professional.prel’. After that save it in a new subfolder, ‘Premier Elements’, which is part
of a main folder: ‘Portrait of a professional’.

In the second row from the top, you can now choose between ‘Quick’ and ‘Expert’ modes.

‘Quick’ gives you one track on the timeline for text/titles, one for video material from your camera (with
accompanying audio track), and two additional audio tracks (one for voice-overs and one for music) in the



editing window below the timeline. The video and audio tracks of your video material are displayed as one in
this mode and can’t be edited separately.

This mode is only suitable for simple film projects where you don’t need several video tracks, and where the
audio content associated with the video track doesn’t have to be edited separately.

In addition, the Quick mode doesn’t include the ‘Project elements’ menu item. Without it you can’t see all the
clips in the project clearly displayed. That’s why it’s better to use the ‘Expert’ mode, even if you don’t need
several video tracks.

In ‘Expert’ mode you can edit four video tracks and their associated audio tracks. Unlike in Quick mode, here
you can edit the audio tracks independently of video material. The ‘Project elements’ menu item is also
available, which means you can see all the content in the project – video and audio files, titles, images and
graphics – neatly arranged.

Another advantage of ‘Expert’ mode is that, if you have video material that was filmed by several different
cameras simultaneously, you can synchronise the ‘action’ across the different video tracks. That way you can
easily choose which camera angles to show at which points. See ‘Editing a video with multiple video tracks’
below for more detail.

There is a third, ‘Wizard Guided Mode’. This provides additional support within both ‘Expert’ and ‘Quick’, and
can give you crash course in video editing.

For the purposes of your imaginary project ‘The portrait of a professional’, you’ll be working in ‘Expert’ mode.

Add Media

The ‘Add Media’ button (top left) allows you to import files from different sources into your project – for example
for a hard disk or a camera connected to your computer.

The ‘Webcam or WDM device’ menu item allows you to record video in Premiere Elements itself, via a
webcam connected to your computer.

Click on ‘Add Media’->’Files and folders’, and in the main folder ‘Portrait of a professional’ find the subfolder
‘interview images’.

Select ‘Import Folder’ to display the subfolder in ‘Project elements’. Once you’ve done that, you can double-click
on ‘Interview sequence’ in the ‘Project elements’  window and see all the video files in that folder. Follow the
same steps to import the subfolder ‘sectional images’.

You can choose how ‘Project elements’ is displayed. Use the small button to the right of the window to
select grid or list view, and to sort elements by file name or duration.

You can also create new folders in ‘Project elements’, for example to sort video material that wasn’t
sorted in the file browser.



Double-click on a video clip in ‘Project elements’, and a small preview window will appear, in which you can
watch the clip.

When you know which section of the clip you want to use in your edited video, move the cursor over the
timeline of the preview window and click to mark the start point of the section. Now click on the ‘Set In-P’ to
properly set the start point. Next, mark the end of the section – again by clicking on a specific point in the
timeline – and select ‘Set Out-P’ to set the end point.

Now ‘Drag & Drop’ the clip from the preview window onto the video track of the main project timeline; only the
section you selected will appear.

This method of adding clips to you film project works well if you’ve already watched your original material in a
video player and noted the timecodes of the sections you want to use. All you have to do is set the start/end
points in Premiere Elements and insert the clip into the main project timeline.

If you haven’t yet watched the material – for example the interview with the craftsman – you can do so in the
editing window:

Double-click on the ‘Interview sequence’ folder in the ‘Project elements’ window.
Select all the files in the folder. You can do this by holding down the ‘Shift’ key and clicking on each file, or
simply by pressing Ctrl + A.
Use ‘Drag & Drop’ to move each file to a video and audio track in the main project timeline.
Start editing your video shot by shot.

Use the scroll bar at the bottom of the editing window to move along the timeline and edit any part of the
project.

The play button under the preview window lets you watch the material in the main project timeline. Use
the spacebar on your keyboard to stop and start the preview more easily.

Use the waste-bin icon in ‘Project Elements’ to delete files or folders you don’t need for your project. Don’t
worry – they won’t be deleted from your hard disk!

The small folder icon left of the waste bin icon helps you switch back from a folder to a higher level.

Use the search bar (magnifying-glass icon) to look for specific files and folders.

The slider on the right of the timeline helps you ‘zoom’ in and out. This allows you to do very detailed
editing work, including focusing on a single frame within a clip if you want to. Or you can see the entire
project at a glance and skip to the section you need.

You can also zoom in and out quickly by using the + and – keys on your keyboard.

After you’ve placed a section of each clip (using In and Out points as described above), or whole clips, in the
Video 1 track of the Timeline, you can start editing them.



The red vertical line which moves along the timeline during playback is called a Current Time Indicator
(‘time indicator’ for short). It gives you your precise time location in the project.Click on the area above the
timeline to jump to a specific point in your video. You can also move the indicator by clicking on the red line
or the blue triangle on top of it, and dragging.

By clicking on the time indicator and dragging it left or right, you’ll be able to hear the sound from the
different clips in very quick succession. This can help you find a specific point on the timeline, like the
end of a sentence.

To edit a clip, move the time indicator to the point where you want to make a cut  and click on the small
scissors you can see next to the indicator. The clip is now split in the video track.
To remove the section before the cut, click on it and select the ‘Remove’ button. Or you can right-
click->’Delete’. This will leave a gap in the timeline. The gap will display as black in the preview (and in the
film) unless there’s overlapping footage in another video track.
You can close the gap with a right-click->’Delete and close gap’. The clip that was right after the gap now
sits next to the clip before it.
Repeat the above steps until you’ve edited the whole interview.

You can also edit a clip by clicking on the start or end of it. A red bracket with two black arrows will appear. Click
on the bracket and move it left or right to make the clip selection shorter or longer, then release.

The key combination Ctrl + Z allows you to undo your last action. You can use it to 50 times.

The ‘Protocol’ panel, accessible via the ‘Window’ menu item, shows you a list of your last 50 actions. You
can now select and undo actions up to a specific point in the editing process. If you have more than 50
actions, or steps, earlier steps won’ t appear in the Protocol panel.

When you close down Premiere Elements, the log of actions from your last session will be lost. When you
open Premiere Elements again, the program will start a new log for any steps in that session.

If you’re not sure about all the changes you’re making, save versions of your project at intermediate
stages, using ‘File->Save As…’. That way, if you don’t think the video is turning out quite like you
planned, you can go back to an earlier version.

Remember to give each version a different name. And don’t worry: saving multiple versions won’t take
up lots of space on your hard disk. You’re only saving the project and not the video files in it, which
have already been saved.

Sectional images

Sectional images make videos more interesting by illustrating the information that a character or, in our case,
an interviewee gives us verbally.

Add relevant video clips from the ‘sectional images’ folder in ‘Project elements’ to the Video 2 track (above
Video 1 track).



You can position the sectional images so that they coincide precisely with the spoken word they’re
illustrating, or a little bit after.
In the first instance the viewer receives the same information both verbally and visually, which
professionals sometimes consider crude. But it’s unavoidable sometimes. If the craftsman is describing
the parts of a machine, the viewer will definitely want to see them at the same time!

Transitions

A clean cut between clips is the most common way of putting different shots together. But gradual shifts, called
transitions, are sometimes more appropriate.

The most common transitions on film and TV are ‘Cross Dissolve’ (slow fade between two clips) and transition to
black.

Transition to black

You can insert a transition to black (look under ‘Transitions’) into your timeline by using ‘Drag & Drop’.
There are several ways you can use it:

On the beginning of the first clip: the video starts with a black screen, followed by a gradual transition to
the first clip.
Between two clips: the picture gradually becomes completely black for a brief time before a transition to
the next clip. In the story of your film this can indicate that time has passed or there has been a change of
location between shots.
At the end of the last clip: the picture dissolves into black, often signalling the end of the film.

Transitions in Premiere Elements

Make sure the cut between two clips is visible in the timeline.1.
Click on ‘Transition’ bottom right and select a type of crossfade. Classic crossfade transitions are listed2.
under ‘scattering’.
Use ‘Drag & Drop’ to insert the crossfade in the relevant cut. A ‘Transition adjustments’ window will appear.3.
Choose how to apply the transition: to the end of the first clip, the start of the second, or both. For both,4.
select ‘between clips’.
Use ‘Duration’ to set the length of the transition in seconds.5.

It’s quite common to create the transitions using so-called ‘white lightnings’, especially when you’re
editing interviews. This is a very quick transition to white, only lasting about two frames.

The minimum transition length you can set in ‘Duration’ is 1 second. So if you want to use a white
lightning, you’ll need to go to Edit-> Preferences-> Set General, and set the ‘default duration of video
transition’ to two frames.



Inserting titles, lower thirds and credits

Before you start inserting titles, lower thirds and credits, right-click on the preview window and select ‘Secure
borders’.

All graphic elements, as well as titles and lower thirds, should be within the outer frame of the displayed
edges. Credits normally move from bottom to top outside the safe margins.

Titles

By clicking on ‘Title and text’ bottom right, you’ll get a variety of different text elements. Some of these are
animated.

For your portrait of a professional:

Give the film a simple title like Industrial mechanic for commercial vehicles – a portrait of John Smith.
To do this, drag the item ‘Standard Text’ and drop it in the relevant place on the timeline, in Video Track 3.
A purple box saying ‘Default Text’ will appear. Double-click on it to edit the text in the preview window. The
‘Adjustments’ window will appear on the right. Use this to change the font, format and alignment (‘Text’
tab), and to select style presets for the style (‘Style’ tab).

Lower thirds

To insert a lower third:

You’ll first need some text at the bottom of the screen (within the safe margins).
As with adding titles, first drag a Standard Text element and drop it in the relevant place on the timelines,
in Video Track 3.
Format the text using ‘Adjustments’
Under the ‘Forms’ tab choose and insert any rectangles, ovals or lines into the preview window. For
example, you could place a rectangle at the bottom of the picture, as long as it’s within the safe margins.
Shape and colour the rectangle, or another shape, in any way you like.
Check the shape isn’t covering any of the text. Right-click on the shape, and select Arrange-> Send to Back.

Press the Escape key after editing a text or shape element. This will allow you to use your cursor again to
move the elements around the preview window.

Credits

After creating your titles and lower thirds, it’s time to work on the credits.

You can use a classic feature-film approach, where job titles and names move slowly from the bottom to the top
of the screen.

In Premiere Elements, go to the ‘Title and Text’ menu item and select the ‘Rolling title’ element. Insert this at a
suitable point in Video Track 3, then edit and format as you would a normal title.



Adding music and voice-overs

In ‘Expert’ mode there are two additional audio tracks in the timeline. One is called ‘Narration’, for any audio
clips of off-camera narration, also known as voice-overs. The other is ‘Soundtrack’, for music.

You can record a voice-over using any sound-recording device, and import it into the project via ‘Project
elements’. Before importing, you could edit the recording using sound-editing software so that it sounds just the
way you want it to.

To decrease/increase the volume of an audio track:

Expand the track by clicking on the small triangle on the left side of the track. A yellow horizontal line will1.
appear.
Click on the line and move it up or down, to increase or decrease the volume respectively. You’ll need to do2.
this for each individual audio clip.
If you want to gradually change the volume of a whole track or part of a track (for example3.
gradually decrease the volume of the music track while the narrator is talking):

Move the cursor to the beginning of a desired slope on the yellow line and click on it while holding
down the Ctrl key; a point (keyframe) will appear
Create another keyframe at the end of the slope (you can still change the position of the keyframes by
dragging them along the yellow line)
Drag the respective keyframes up or down to create slopes in the yellow line. A downward slope means
a gradual decrease and an upward slope is a gradual increase in the volume.
Insert as many points as you need to make the adjustments you want.

Applying video and audio effects in Premiere Elements

You can go further and add various effects to your video and audio material in Premiere Elements.

For video effects, click on Effects, choose a category and a specific effect, then drag this on top of a clip in the
editing window.

For audio effects, select Audio->Sound effects, then drag the effect you want onto an audio clip in the editing
window.

Once you’ve added an effect to a clip, an ‘Assigned effects’ menu will on the right of your screen. Use this to
change your effect settings.

You can’t add a new effect to several clips simultaneously. However, once you’ve added one or more effects to
a single clip and you’re happy with the result, you can apply the same effect settings to several clips at the
same time.

To do this, right-click on the edited clip and select ‘Copy’. Then select the clips that you want to apply the same
effects to. Right-click and select ‘Insert effects and adjustments’. After that you can further
customise the effects of each clip individually if you want to.



Additional music

You can also use the Audio menu to insert additional music into your project. Select Audio->Music score, and
pick a genre – for example Blues. Click on an audio clip and drag it onto an audio track in your editing window.

Additional customizations

The ‘Customize’ menu top right offers many other ways of modifying the material in your project.

For example, you can use ‘Intelligent Auto Color Correction’ to give you uniform colour tones across footage
from different cameras. Browse the various options and experiment!

Encoding video in various file formats

After you’re done editing your video in Premiere Elements, decide how you want to publish it in: for example
as a DVD or on an online video platform. This will determine what file format you’ll be exporting your project to.

Exporting a video in Premiere Elements is covered in detail in Encoding files for archiving, online uploads and
video discs.

Editing video with multiple video tracks

Let’s say you’ve used several different cameras to shoot a film scene, an interview or an event. In Premiere
Elements’ ‘Expert’ mode you can synchronise and edit all of that material using multiple video tracks.

To show you how this works, we’ll use the following example: an interview shot simultaneously on two cameras,
using the shot/counter-shot principle.

Set up a clear folder structure on your computer.The main folder for your video is called, for example,1.
‘Interview with Jan Feddersen’. It has two subfolders: ‘Camera 1’, for material from the camera that mainly
filmed the interviewer, and ‘Camera 2’,  for material from the camera that mainly filmed the interviewee.
There may of course also be some shots of both people together.
Import both subfolders in ‘Project elements’. You can now see multiple video tracks, associated with audio2.
tracks: Video 1 and Audio 1; Video 2 and Audio 2; Video 3 and Audio 3.
Put all the clips from Camera 1 in the Video 2/Audio 2 tracks. Then put all the clips from Camera 2 in the3.
Video 1/Audio 1 tracks. There’s a reason for putting Camera 1 material in Video 2/Audio 2, and Camera 2
material in Video 1/Audio 1. Camera 1 material mainly shows the interviewer, and we won’t be using that
much of it in the final cut. The preview window (and thus also the finished film) always shows the content of
the highest video track, so it makes sense to use track 2 for material from Camera 1, showing the
interviewer.
If you can’t see the Video 3 track, use the scroll bar on the right of the timeline panel to scroll up and reveal4.
it. This is the track to use for sectional images, titles and lower-thirds, for example.

As you’ll remember, both cameras filmed the interview simultaneously from different positions. Now you can go
ahead and synchronise the clips in video/audio tracks 1 and 2.
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There are two ways of doing this:

Synchronisation using audio tracks: If both cameras recorded sound, you can synchronise their video and1.
audio material using the audio tracks.Ideally you’ll have used a clapper board or clapped your hands to
create a synchronising sound at the beginning of the interview, with both cameras rolling. But you can also
synchronise audio tracks without a synchronisation sound.In both cases, click on the triangles left of
the audio track names to expand them; now you can see the waveform of each one. They will be similar
where both cameras recorded the same thing.Zoom in to find the synchronisation sound. Once you’ve
seen it on both audio tracks, select the whole video and audio material of one of the video/audio tracks, and
slide it over until the two synchronisation-sound points are aligned.To check it’s worked, play both tracks. If
you haven’t synchronised them well, you’ll hear something that sounds very much like reverb.
Synchronisation using video tracks: A clapperboard or someone clapping can help here too, but2.
another distinctive movement will also do.Find the bang of the clapperboard or the hands clapping on both
video tracks, and use this to bring the two sets of video and audio tracks roughly in line.Now expand the
upper video track (2) by clicking on the triangle next to the track name. You’ll see all the video clips in
that video track, and horizontal yellow line.Click on the line and drag it down slightly to make it transparent;
you can now see the picture in the video track under it. Use this to find the exact location of the bang or
clap and more one of the video tracks left or right the two are completely synchronised.Check the
synchronisation by listening to the sound in the audio tracks. If there’s only one audio track, check the lip-
syncing between sound and picture.Use the transparency function to check for synchronicity across video
tracks elsewhere on the timeline.

Once your video tracks are synchronised, you can go ahead and edit them as you would a single video track.
Just remember to uncheck any options for editing both tracks simultaneously, and to always make sure you’ve
selected the precise clip you want to edit.

Common mistakes

Not saving your project regularly. If the program crashes, you might lose a lot of work. Premiere
Elements auto-saves your work every 20 minutes, so you may be able to restore some of what you’ve done,
but everything before the last auto-save would be lost.
Not storing all the material for the video project in the same main folder (or its subfolders). If, for example,
you transfer some clips from the main folder from your hard disk to an external storage device and you
switch it of and then try to play the project, there will be gaps where the missing material is supposed to
be.
One person only does all the editing and there’s no regular discussion with the rest of the group about what
the final result should look like. Some people might be unhappy with the finished video, or you might need
to put a lot of time in undoing your work and changing things round.

Exercises

You’ll have the most fun with editing if you’re working on your own film project. Apply the examples we give
here to your video and get started!



Related topics and links to external resources

Chapters: Film Structure / Free internet resources to support your video work / Encoding files for archiving,
online uploads and video discs

Methodology

Long periods of working at a computer can be boring for teenagers. Plus, you can only really have two people
editing a video on the same computer at any one time.

Split the young people into groups and rotate them frequently during the editing stage, even if this affects the
quality of the finished film. It’s the only way to make sure all of the participants develop video-editing skills.

Helping the young people learn is more important than the final product. Discuss the editing process with
them, and give them the support they need. If you can, connect the computer to a projector so that more
project participants can follow the editing stage.

Remember to offer additional activities for those who aren’t involved in the editing process. Some young people
could create posters about the project or the theme of the video. Others could use a camera and microphone to
interview their fellow project participants as the project progresses and the video develops.

Physical activities that are not directly related to the project are great too, for example movement or theater-
improvisation games.

 Terminology

editing window, preview window, import files, current time indicator, transitions, titles, lower thirds, credits,
synchronisation
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